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Теория

Микрополосковые фильтры играют важную роль во входных РЧ-трактах, заключающуюся 
в подавлении сигналов, выходящих за пределы полосы. Они широко применяются в 
вариантах с сосредоточенными и распределенными параметрами как в коммерческих 
изделиях, так и в изделиях военного назначения. Фильтр является реактивной схемой, 
пропускающей частоты желаемой полосы и при этом почти полностью задерживающей 
частоты всех других полос. Частота, отделяющая полосу пропускания от полосы 
заграждения называется частотой среза и обозначается fc. Ослабление фильтра 
выражается в децибелах или неперах. Вообще говоря, фильтр может иметь любое 
количество полос пропускания, разделенных полосами заграждения. Большинство 
фильтров относятся к четырем наиболее распространенным типам, а именно: фильтры 
низких частот (ФНЧ), высоких частот (ФВЧ), полосовые и режекторные.

У идеального фильтра должны отсутствовать вносимые потери в полосе пропускания, 
ослабление в полосе заграждения должно быть бесконечным, а ФЧХ в полосе пропускания 
должна быть линейной. Идеальный фильтр нереализуем, поскольку характеристика 
идеального ФНЧ или ФВЧ в частотной области имеет форму прямоугольного импульса. 
Искусство разработки фильтров требует идти на компромиссы в отношении среза и 
завала (крутизны) характеристик. Существует три основных метода синтеза фильтров. Это 
метод параметров образа, метод вносимых потерь и числовой синтез. Метод параметров 
образа – старый и очень приближенный, тогда как числовой метод синтеза новее, но при 
этом громоздкий. Что же касается метода вносимых потерь для разработки фильтров, то 
он является оптимальным и более популярным методом для высокочастотных задач. Ниже 
приведена процедура разработки методом вносимых потерь.
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Рис. 131.

Выберите прототип для желаемых 
частотных характеристик (всегда 

создаются нормализованные значения и 
схема ФНЧ)

Выполните преобразование для 
получения желаемой полосы частот 
и характеристического импеданса 

(создается схема с сосредоточенными 
параметрами)
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микрополосковой)

Соединенные последовательно 
микрополосковые линии. 

Каждая секция < λg/4 
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одиночного типа, после чего используйте 

реализацию каскада полуволнового 
резонатора с параллельной связью
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Так как характеристики идеального фильтра получить невозможно, цель разработки 
фильтра – приблизиться к идеальным требованиями с приемлемым допуском. Существует 
четыре типа аппроксимаций, а именно: аппроксимация Баттерворта (или максимально 
плоская аппроксимация), Чебышева, Бесселя и эллиптическая. При выборе прототипа 
фильтра максимально плоская аппроксимация, или аппроксимация Баттерворта, 
обеспечивает самую плоскую характеристику в полосе пропускания для данного 
порядка фильтра. При использовании метода Чебышева достигается более крутой срез, 
а характеристика в полосе пропускания будет иметь колебания с амплитудой 1+k2. 
Аппроксимации Бесселя основаны на функции Бесселя, которая обеспечивает более 
крутой срез, а эллиптические аппроксимации приводят к колебаниям характеристики 
в полосах пропускания и заграждения. Можно выбирать различные аппроксимации в 
зависимости от задачи и стоимости. С позиций характеристики и перечня элементов 
оптимальным фильтром является фильтр Чебышева. С использованием приведенных 
выше аппроксимаций фильтр можно разработать как с сосредоточенными, так и с 
распределенными параметрами.

Разработка СВЧ фильтров
Первым шагом в разработке СВЧ фильтров является выбор подходящей аппроксимации 
модели прототипа исходя из технических параметров.

Рассчитайте порядок фильтра из требуемой крутизны характеристики на основе заданных 
технических характеристик. Порядок можно рассчитать следующим образом:

Аппроксимация Баттерворта:

L
A
 (ω’) = 10log 

10
 {1+ ε (ω’/ ω

c
) 2N }

где ε = {Antilog
10

 L
A
/10} -1 и L

A
= 3 дБ для аппроксимации Баттерворта

Аппроксимация Чебышева:

где ω
c
 – круговая частота среза

ω’ – круговая частота ослабления

L
A
(ω’) – ослабление при круговой частоте ω’

N – порядок фильтра

ε = {Antilog
10

 L
Ar 

/10} -1 и L
Ar

 = колебания в полосе пропускания

Следующий шаг при разработке фильтра заключается в расчете параметров прототипа 
фильтра в зависимости от типа аппроксимации. Параметры прототипа для аппроксимаций 
Чебышева и Баттерворта могут быть получены с помощью приведенных выражений.

при

при и
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Аппроксимация Баттерворта:

g0 =1,

g
k
 = 2sin {(2k-1)π/2n}, где k = 1,2,….n    и

g
N+1

 =1

где n – порядок фильтра

Аппроксимация Чебышева:
Значения элементов могут быть рассчитаны следующим образом:

После расчета параметров прототипа необходимо преобразовать прототип фильтра 
так, чтобы частота и импеданс соответствовали техническим характеристикам. 
Преобразования могут быть выполнены с помощью следующих выражений.

Для НЧ фильтра:

После масштабирования импеданса и частоты:

C’
k
=C

k
/R

0
 ω

c

L’
k
=R

0
L

k
/ω

c
 , где R

0
 = 50 Ом

– колебания в полосе пропускания

при нечетном n

при четном n
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Для схемы с распределенными параметрами электрическая длина следующая:

Длина емкостного участка: Z
I
/R

0
 C

k
,

Длина индуктивного участка:  L
k
 R

0
/Z

h

где Z
l
 – значение низкого импеданса, Z

h
 – значение высокого импеданса

Для полосового фильтра:

Масштабирование импеданса и частоты:
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1
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0
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где ∆ – относительная ширина полосы  ∆ = ( ω
2
- ω

1
)/ ω

0

Номинальные характеристики
Частота среза (f

c
) : 2 ГГц

Ослабление при f = 4 ГГц : 30 дБ (LA(ω))

Тип аппроксимации : Баттерворта

Порядок фильтра : LA (ω) = 10log
10

 {1+ε (ω/ ω
c
) 2N

где, ε = {Antilog
10

 LA/10} -1

При подстановке значений LA (ω), ω и ω
c
 рассчитанное значение N будет равно 4.

Параметры прототипа НЧ фильтра
Параметры прототипа фильтра рассчитываются с помощью следующих формул

g
0
 =1,

g
k
 = 2sin {(2k-1)π/2N}, где k = 1,2,….N

и g
N+1

 =1

Симуляция НЧ фильтров с сосредоточенными и распределенными 
параметрами в ADS
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Параметры прототипа для заданных технических характеристик фильтра:

g1 = 0,7654 = C
1
, g2 = 1,8478 = L

2
, g3 = 1,8478 = C

3
и g4 = 0,7654 = L

4

Модель фильтра с сосредоточенными параметрами
Значения сосредоточенных параметров НЧ фильтра после масштабирования частоты и 
импеданса:

C
k
’= C

k
 /R

0
ω

c

L
k
’=R

0
 L

k
 /ω

c
 , где R

0
 = 50 Ом

В результате получаются следующие значения сосредоточенных параметров: C
1
 = 1,218 пФ, 

L
2
 = 7,35 нГн, C

3
 = 2,94 пФ и L

4
 = 3,046 нГн

Модель фильтра с распределенными параметрами

Для схемы с распределенными параметрами электрическая длина составляет:

Длина емкостного участка (βLc) : C
k
 Z

l
/R

0

Длина индуктивного участка (βLi) : L
k
 R

0
/Z

h

где,

Z
l
 – значение низкого импеданса

Z
h
 – значение высокого импеданса

R
0
 – импеданс источника и нагрузки

ω
c
 – желаемая частота среза

Если мы примем Z
l
 = 10 Ом и Z

h
 = 100 Ом, то βLc

1
 = 0,153,  

βLi
2
 = 0,9239,

βLc
3
 = 0,3695 и βLi

4
 = 0,3827

Поскольку β = 2π/λ, физические длины составят

Lc
1
 = 1,68 мм

Li
2
 = 10,145 мм

Lc
3
 = 4,057 мм и

Li
4
 = 4,202 мм
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Порядок действий при схемотехнической симуляции НЧ фильтра с 
сосредоточенными параметрами

1. Откройте окно схемы Schematic ADS.
2. Из библиотеки компонентов с сосредоточенными параметрами выберите 

подходящие компоненты, необходимые для схемы фильтра с сосредоточенными 
параметрами. Нажмите на необходимые компоненты и вставьте их в окно схемы ADS, 
как показано на рисунке.

3. Создайте модель НЧ фильтра с сосредоточенными параметрами в окне схемы с 
использованием подходящих компонентов с сосредоточенными параметрами и 
соедините элементы схемы с помощью проводников . Введите рассчитанные 
ранее значения компонентов.

4. Подключите нагрузку к обоим портам НЧ фильтра, используя нагрузки, выбранные 
из библиотеки Simulation-S_Param (Симуляция – S-параметры).

5. Вставьте контроллер симуляции S-параметров из библиотеки Simulation-S_Param и 
задайте для него следующие параметры:

 Start (Начальная частота) = 0.1 GHz
 Stop (Конечная частота) = 5 GHz
 Number of Points (Количество точек) = 101 (или введите значение Step Size (Размер 

шага) = 49 MHz)

В результате будет создана модель фильтра с сосредоточенными параметрами, как 
показано на рисунке ниже.

Рис. 132.

Рис. 133.
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6. Выполните симуляцию схемы, нажав клавишу F7 или иконку симуляции с 
изображением шестеренки.

7. По завершении симуляции, ADS автоматически откроет окно дисплея данных, в 
котором будут отображены результаты. Если данное окно не открылось, нажмите 
Window > New Data Display (Окно > Новый дисплей данных). В окне дисплея данных 
выберите график в прямоугольной системе координат. При этом автоматически 
откроется окно вставки атрибутов. Выберите параметры, графики которых 
требуется построить (в нашем случае графики S(1,1) и S(2,1) в дБ), и нажмите Add>> 
(Добавить>>).

8.  Нажмите на график  S(2,1) и установите на него маркер в области 2 ГГц, чтобы 
просмотреть график с отображением данных, как показано ниже.

Рис. 134.

Результаты и данные наблюдения
В результате схемотехнической симуляции было замечено, что модель НЧ фильтра с 
сосредоточенными параметрами обладает частотой среза 2 ГГц и крутизной среза, 
соответствующими техническим характеристикам.

Порядок действий при топологической симуляции НЧ фильтра с 
распределенными параметрами
Рассчитайте физические параметры НЧ фильтра с распределенными параметрами по 
приведенной выше процедуре разработки фильтра. Рассчитайте ширину линий передачи 
с импедансами Z

l
 и Z

h
 для конструкции НЧ фильтра со ступенчатым импедансом. В этом 

случае Z
l
 = 10 Ом и Z

h
 = 100 Ом, а ширина соответствующих линий составляет 24,7 мм и 

0,66 мм при диэлектрической проницаемости 4,6 и толщине 1,6 мм.

Рассчитайте длину и ширину линии 50 Ом с помощью окна калькулятора линий ADS  
(Tools->Line Calc->Start Line Calc (Инструменты->Калькулятор линий->Запустить 
калькулятор линий)), как показано на рисунке ниже.

Линия соединения 50 Ом на входе и выходе:
Ширина: 2,9 мм

Длина: 4,5 мм
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Рис. 135.

Рис. 136.

Создайте модель НЧ фильтра в окне топологии ADS. Модель можно создать, 
воспользовавшись доступными библиотечными компонентами либо нарисовав 
прямоугольники.

Для создания модели с применением библиотечных компонентов выберите библиотеку 
TLines – Microstrip (Линии передачи – Микрополосковые). Выберите из библиотеки 
подходящую микрополосковую линию и вставьте ее в окно топологии, как показано на 
рисунке:
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Завершите создание модели, соединив линии передачи так, чтобы сформировался НЧ 
фильтр со ступенчатым импедансом на основе выполненных ранее расчетов ширины и 
длины, как показано на рисунке ниже.

Рис. 137.

Подключите выводы (Pin) на входе и выходе, задайте структуру слоев подложки и 
настройте ЭМ симуляцию в соответствии с приведенным ранее описанием в разделе по ЭМ 
симуляции. Мы должны использовать следующие свойства структуры слоев:

Er (Диэлектрическая проницаемость) = 4.6
Height (Высота) = 4.6 mm
Loss Tangent (Тангенс угла потерь) = 0.0023
Metal Thickness (Толщина металла) = 0.035 mm
Metal Conductivity (Проводимость металла) = Cu (5.8E7 S/m)

В окне настройки электромагнитной симуляции перейдите на вкладку Options > Mesh 
(Опции > Сетка) и включите опцию Edge Mesh (Краевая сетка).

Нажмите кнопку Simulate (Симулировать) для просмотра характеристик S11 и S21.

Рис. 138.
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Можно заметить, что частота среза по уровню 3 дБ смещена к значению 1,68 ГГц вместо 
того, чтобы быть равной 2 ГГц, поскольку наши теоретические расчеты не позволяют точно 
проанализировать влияние открытого конца и резкого изменения импеданса в линиях 
передачи, поэтому длины линий необходимо оптимизировать для получения желаемой 
частоты среза 2 ГГц.

Эта оптимизация может быть проведена с помощью симулятора Momentum в ADS или 
путем параметрического свипирования длин емкостных и индуктивных линий.

Параметрическая электромагнитная симуляция в ADS
Для того, чтобы приступить к параметрической топологической симуляции, нам 
необходимо задать переменные параметры, которые должны быть связаны с 
компонентами топологии. Нажмите EM > Component > Parameters (Электромагнитная 
симуляция > Компонент > Параметры) в соответствии с рисунком ниже.

Рис. 139.

Рис. 140.
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В открывшемся окне параметров задайте 4 переменных для емкостных и индуктивных 
линий и введите их номинальные значения с соответствующими единицами измерения. 
Задайте Type (Тип) = Subnetwork (Подсхема), так как эти параметры будут относиться к 
компонентам библиотеки микрополосковых элементов, у которой есть параметрический 
шаблон. Если мы хотим использовать параметризацию для компонентов на основе 
полигонов или прямоугольников, мы можем выбрать метод Nominal/Perturbed 
(Номинальные значения/Отклонения), при котором требуется дополнительно уделить 
внимание способу параметризации компонентов.

Рис. 141.

Когда параметры будут добавлены в список, дважды нажмите на соответствующие 
компоненты и введите имена соответствующих переменных. Обратите внимание, что 
здесь не требуется задавать единицы, поскольку мы их уже задали в списке переменных 
параметров. Пример для одного из компонентов показан на рисунке ниже:

Рис. 142.

Рис. 143.

После задания всех значений параметров для желаемых компонентов топологии 
мы можем создать ЭМ модель и символ, которые можно затем использовать для 
параметрической совместной ЭМ симуляции в схеме. Для создания параметрической 
модели и символа для топологии, нажмите на опцию EM > Component > Create EM Model 
and Symbol (Электромагнитная симуляция > Создать электромагнитную модель и символ).
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Рис. 145.

Откройте новую схемотехническую ячейку и, перетащив компонент emModel (ЭМ 
модель), вставьте его как подсхему. Вы увидите, что заданные параметры добавляются к 
компоненту emModel, для которого может быть затем выполнено свипирование с помощью 
обычного компонента Parameter Sweep (Свипирование параметра) в окне схемы ADS, как 
показано ниже. В данном случае мы задали переменные L1-L4 и связали их с компонентом 
emModel. Для начала мы выполним свипирование длины компонента L2 (1-я индуктивная 
линия) от 6,145 до 12,145 с шагом 1.

На этом этапе мы можем решить настроить оптимизацию, а затем оптимизировать 
переменные топологического компонента подобно любой другой оптимизации схемы. 
Однако заметьте, что электромагнитная оптимизация займет больше времени в сравнении 
с оптимизацией на основе схемы, но создаст более точную характеристику, поскольку 
электромагнитная симуляция будет выполняться для каждой комбинации.

Рис. 144.

По завершении просмотрите содержание окна ADS, в котором под названием 
топологической ячейки отображается название ЭМ модели и символа, как показано ниже:
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На дисплее данных мы можем видеть, что при 1-ом значении свипирования L2 частота 
среза по уровню 3 дБ составляет 2 ГГц, т. е. похоже, что правильное значение L2=6,145 мм.

Отключите свипирование параметра, измените значение L2 = 6.145 mm и вновь выполните 
симуляцию, чтобы просмотреть характеристику фильтра. Если от схемы ожидаются 
лучшие обратные потери, можно выполнить ее электромагнитную оптимизацию.

Рис. 147.

Результаты и данные наблюдения

В результате топологической симуляции было определено, что после параметрического 
электромагнитного анализа частота среза по уровню 3 дБ НЧ фильтра составляет 2 ГГц.

Рис. 146.

Нажмите на иконку  Simulate (Симулировать) и постройте график в окне дисплея 
данных, чтобы увидеть, как меняется характеристика фильтра с изменением длины 1-й 
индуктивной линии.
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Номинальные характеристики
Верхняя частота среза (f

c1
) : 1,9 ГГц

Нижняя частота среза (f
c2

) : 2,1 ГГц
Колебания в полосе пропускания : 0,5 дБ
Порядок фильтра : 3

Тип аппроксимации : Чебышева

Параметры прототипа фильтра
Параметры прототипа фильтра для аппроксимации Чебышева рассчитываются с помощью 
приведенных выше формул.

Для заданных технических характеристик фильтра параметры прототипа составляют:
g1 = 1,5963, g2 = 1,0967 и g3 = 1,5963

Модель фильтра с сосредоточенными параметрами
Значения сосредоточенных параметров полосового фильтра после масштабирования 
частоты и импеданса:
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В результате получаются следующие значения сосредоточенных параметров:

L’
1
 = 63 нГн

C’
1
= 0,1004 пФ

L’2 = 0,365 нГн

C’
2
 = 17,34 пФ

L’
3
 = 63 нГн

C’
3
 = 0,1004 пФ

Схема полосового фильтра на элементах с сосредоточенными параметрами приведена на 
следующем рисунке.

Симуляция полосового фильтра с сосредоточенными и распределенными 
параметрами в ADS
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Модель фильтра с распределенными параметрами
Рассчитайте значение j исходя из параметров прототипа следующим образом:

где ∆ = (ω
2
 – ω

1
)/ω

0

Z
0
 = характеристический импеданс = 50 Ом

Значения импедансов четных и нечетных мод могут быть рассчитаны следующим образом:
 

z
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Рис. 148.
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Порядок действий при схемотехнической симуляции полосового 
фильтра с сосредоточенными параметрами
Откройте окно схемы ADS и соберите полосовой фильтр с сосредоточенными параметрами, 
как показано ниже. Задайте следующие настройки симуляции S-параметров: от 1 ГГц до 
3 ГГц с шагом 5 МГц (401 точка).

Рис. 149.

для
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Результаты и данные наблюдения
В результате схемотехнической симуляции было определено, что модель полосового 
фильтра с сосредоточенными параметрами имеет нижнюю частоту среза 1,9 ГГц, верхнюю 
частоту среза 2,1 ГГц и крутизну среза, соответствующие техническим характеристикам.

Порядок действий при топологической симуляции полосового 
фильтра с распределенными параметрами
Рассчитайте значения импедансов полосового фильтра для нечетных и четных мод (Zoo и 
Zoe) по приведенной выше процедуре разработки фильтра. Синтезируйте геометрические 
параметры (длину и ширину) связанных линий для толщины подложки 1,6 мм и 
диэлектрической проницаемости 4,6.

Геометрические параметры связанных линий для данных значений Zoo и Zoe следующие:

Толщина подложки: 1,6 мм
Диэлектрическая проницаемость: 4,6
Частота: 2 ГГц
Электрическая длина: 90 градусов

Участок 1: Zoo = 36,23, Zoe = 66,65
 Ширина = 2,545
 Длина = 20,52
 Зазор = 0,409

Участок 2: Zoo = 56,68, Zoe = 44,73
 Ширина = 2,853
 Длина = 20,197
 Зазор = 1,730

Рис. 150.

Нажмите на иконку Simulate (Симулировать) для просмотра показанного ниже графика:
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Рассчитайте длину и ширину линии 50 Ом с помощью окна  linecalc (Калькулятор линий)
ADS, как это делалось ранее.

 – Линия 50 Ом:
 – Ширина: 2,9 мм
 – Длина: 5 мм

Создайте модель полосового фильтра в окне топологии ADS. Модель можно создать, 
воспользовавшись доступными библиотечными компонентами либо нарисовав 
прямоугольники.

Для создания модели с применением библиотечных компонентов выберите компонент 
MCFIL из библиотеки TLines – Microstrip (Линии передачи – Микрополосковые). Выберите 
из библиотеки подходящий тип микрополосковой линии и вставьте ее в окно топологии, 
как показано на рис. 152.

Рис. 151.

Участок 3: Zoo = 56,68, Zoe = 44,73
 Ширина = 2,853
 Длина = 20,197
 Зазор = 1,730

Участок 4: Zoo = 36,23, Zoe = 66,65
 Ширина = 2,545
 Длина = 20,52
 Зазор = 0,409
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Настройте электромагнитную симуляцию по указанной ранее процедуре для диэлектрика 
FR4 толщиной 1,6 мм и выполните симуляцию Momentum от 1 ГГц до 3 ГГц. Не забудьте 
включить опцию Edge Mesh (Краевая сетка) на вкладке Options > Mesh (Опции > Сетка) 
окна EM Setup (Настройка электромагнитной симуляции).

По завершении симуляции постройте характеристики S11 и S21 полосового фильтра, как 
показано ниже:

Результаты и данные наблюдения
Результаты для фильтра на элементах с сосредоточенными параметрами хорошие, но 
необходима симуляция этой схемы и, возможно, ее повторная оптимизация с применением 
библиотек компонентов поставщиков, и нам требуется выполнить симуляцию с анализом 
выхода годных, чтобы учесть разброс характеристик, который может быть вызван 
допусками сосредоточенных компонентов.

Что касается фильтра с распределенными параметрами, для получения лучших 
характеристик полосового фильтра, если это потребуется из-за того, что 
электромагнитная симуляция указывает на небольшое ухудшение рабочих характеристик 
полосового фильтра, мы можем дополнительно оптимизировать его конструкцию, 
воспользовавшись схемотехническим симулятором или электромагнитным симулятором 
Momentum.

Поздравляем! Вы завершили раздел «Разработка СВЧ-фильтра на дискретных элементах 
и микрополоскового СВЧ-фильтра». Дополнительные примеры вы найдете здесь:  
www.Keysight.com/find/eesof-ads-rfmw-examples

Рис. 153.

Рис. 152.

http://www.Keysight.com/find/eesof-ads-rfmw-examples
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